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H

 TML (Hypertext Markup Language) เปนภาษาสําหรับกําหนดโครงรางของเอกสารเว็บเพจในรูปแบบ 

 แท็ก (Tag) เชน <html>, <head>, <body> เปนตน ถึงแมในปจจุบันจะมีเทคโนโลยีเกี่ยวกับเว็บออกมา 

อยางมากมาย แตเรายังตองใช HTML ในการจดัวางโครงรางของเอกสารเหมอืนเดมิ โดยเนือ้หาในบทนี ้นอกจาก

เราจะไดศกึษาเกีย่วกบัแทก็พืน้ฐานทีส่าํคญัของ HTML แลว ยงัจะกลาวถงึ Visual Studio Code ซึง่เปนเครื+องมอื 

สําหรับการเขียนโคดและทดสอบเว็บเพจอีกดวย

การติดตั้งและใชงาน VS Code
การเขียนโคดของเว็บเพจ เชน HTML5 รวมถึง CSS3 นั้น เราสามารถใชโปรแกรมประเภท Text Edi-

tor ตัวใดก็ได สําหรับในหนังสือเลมนี้ ผูเขียนเลือกใช Visual Studio Code (ตอไปจะเรียกสั้น ๆ  วา VS Code) 

ดวยเหตุผลดังนี้

 เปนโปรแกรมประเภท IDE (Integrated Development Environment) สําหรับการเขียนโคดทั่วไป

ที่มีขนาดไมใหญมาก และไดรับความนิยมสูงสุดในปจจุบัน

 รองรับการเขียนโคดไดหลากหลายภาษา เชน HTML, JavaScript, Java, PHP, Python เปนตน  

แตอยางไรกต็าม เราอาจตองตดิตัง้สวนเสรมิและตวัแปลภาษานัน้ ๆ  เพิม่เตมิเขามาอกี ยกเวน HTML 

เพราะตองเปดแสดงผลดวยเว็บเบราวเซอร

 ทํางานไดอยางชาญฉลาด พรอมตัวชวยในการเขียนโคดอยางครบครัน รวมถึงยืดหยุนตอการปรับ

แตงใหสามารถใชรวมกับภาษาคอมพิวเตอรอื+น ๆ  ไดเปนอยางดี

 มีสวนเสริมการทํางานใหเลือกใชมากมาย และสามารถนํามาใชงานไดฟรี

VS Code  
และพื้นฐาน HTML5
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สาํหรับชุดตดิตัง้ VS Code สามารถดาวนโหลดไดจากเวบ็ไซต https://code.visualstudio.com/download  

หลังจากดาวนโหลดเสร็จ ก็ใหดับเบิลคลิกไฟลติดตั้ง ซึ่งขั้นตอนตาง ๆ  ก็ทําเหมือนกับโปรแกรมทั่วไป

VS Code เปน IDE สําหรับการเขียนโคดทั่วไปที่ไมเจาะจงวาเราตองใชภาษาใด ดังนั้น เครื+องมือและตัว

ชวยตาง ๆ  ก็เปนลักษณะพื้นฐานที่สามารถนําไปใชไดกับภาษาคอมพิวเตอรเกือบทั้งหมด โดยลักษณะที่นQาสนใจ

ซึ่งบางครั้งเราอาจนําไปใชงานได มีดังนี้

การเปลี่ยนรูปแบบสีของ VS Code
รูปแบบสีหรือ Color Theme ที่ VS Code เลือกไวลวงหนา จะเปนสีดํา (Dark) แตหากเราไมชอบสีนี้ 

VS Code ก็มีรูปแบบสีมาใหเลือกบางสวน ซึ่งขั้นตอนคือ

1. ที่มุมลางซาย คลิกที่ไอคอน Manage 

2. เลือกเมนู Color Theme แลวเลือกรูปแบบสีที่ตองการ

1

2
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การยอและขยายขนาด (Zoom Out & Zoom In)
ขนาดปกติของฟอนตและไอคอนที่ VS Code กําหนดไวลวงหนา อาจคอนขางเล็กสําหรับบางคน ดัง

ภาพตอไปนี้ (ซาย)

 

 หากเราตองการใหฟอนตและไอคอนมีขนาดใหญอีก 1 ระดับ ก็เลือกที่เมนู View > Appearance >  

Zoom In หรือกด <Ctrl => และถาทําเชนนี้อีก ขนาดจะเพิ่มขึ้นอีก 1 ระดับ ดังภาพบนดานขวามือ 

 หากเราตองการใหขนาดของฟอนตและไอคอนเลก็ลง 1 ระดบั กเ็ลอืกทีเ่มน ูView > Appearance >  

Zoom Out หรือกด <Ctrl -> และถาทําเชนนี้อีก ขนาดจะลดลงอีก 1 ระดับ

การกําหนดรูปแบบฟอนตของ Code Editor
หากเราตองการปรับเปลี่ยนฟอนตของ Code Editor ก็มีขั้นตอนดังนี้

1. คลิกที่ไอคอน Manage ตรงมุมลางซาย

2. เลือกที่เมนู Settings

3. เลือกแท็บ User

4. คลิกที่ Text Editor

5. คลิกเมนู Font

จากนั้นก็กําหนดรูปแบบฟอนตตามที่เราตองการ เชน Font Family (ชนิดฟอนต) Font Size และ Font 

Weight เปนตน
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1

2

   

3

4

5

การติดตั้งสวนขยายของ VS Code
การเขยีนโคดในบางกรณ ีเราอาจตองใชสวนขยาย (Extension) สําหรับการทาํงานรวมกบัภาษานัน้ ๆ  ซึง่

เราสามารถตรวจสอบและดาวนโหลดสวนขยายมาใชงานไดดังนี้

1. ในขณะนั้น ตองเชื+อมตอกับอินเทอรเน็ต แลวคลิกที่ไอคอน Extensions ที่ขอบดานซาย (ดูภาพถัด

ไป) หรือเลือกที่เมนู View > Extensions

2. ใสคียเวิรดลงไป หลังจากนั้นจะปรากฏรายชื+อสวนขยายที่อาจเกี่ยวของกับคียเวิรดดังกลาว 

3. ถาเราตองการติดตั้งสวนขยายใด ก็คลิกปุม Install บนรายการนั้น หรือหากตองการดูรายละเอียด

เพิ่มเติมเกี่ยวกับสวนขยายใด ก็คลิกที่รายการดังกลาว ดังภาพ

1

3

2
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4. ถาคนหาสวนขยายที่ถูกติดตั้งเอาไวแลว จะมีรูป

ไอคอน Manage ที่มุมลางขวาของรายการนั้น ทั้งนี้

หากเราตองการลบสวนขยายนั้นทิ้งไป ก็ทําดังนี้   

(1) คลิกที่รูปไอคอนดังกลาว  (2) เลือกที่ Uninstall 

การทดสอบเว็บเพจดวย Live Server
เนื+องจากในหวัขอตอ ๆ  ไปของบทน้ี เราตองเปดดผูลลพัธดวยเว็บเบราวเซอร ซึง่โปรแกรม VS Code น้ัน  

ไมมีเครื+องมือที่รองรับการทดสอบเชนน้ีโดยตรง แตเราสามารถติดตั้งสวนเสริม

ของ VS Code สําหรับสรางเซิรฟเวอร (Server) แบบจําลอง เพื+อเปดไฟลเว็บ

เพจดวยเบราวเซอรโดยตรงได ดงันัน้ การตรวจสอบผลลพัธจงึสะดวกรวดเร็วยิง่

ขึ้น ซึ่งมีขั้นตอนดังนี้

1. เปดเขาสู VS Code แลวคลกิทีไ่อคอน Extensions ทีแ่ถบดานซายมอื  

(ตองเชื+อมตออินเทอรเน็ต)

2. ในชองคนหา ใหพิมพคําวา Live Server ลงไป

3. หลังจากปรากฏรายชื+อสวนเสริม Live Server ใหคลิกปุม Install

หลังการติดตั้ง ใหลองทดสอบการทํางานของ Live Server ดังขั้นตอนตอไปนี้

 ขอบงัคับของ Live Server คอื เราตองมีโฟลเดอรทีแ่นQนอนในการจดัเกบ็ไฟลเวบ็เพจ โดยในทีน่ีผู้เขยีน 

จะเกบ็ไฟลสาํหรบัทดสอบไวที ่C:\bvn\html5 ดังนัน้ ใหเราสรางโฟลเดอรวาง ๆ  ตามนีข้ึน้มากอน จะดวย 

วิธีใดก็ได

 ที่ VS Code ใหเปดโฟลเดอรโดยเลือกเมนู File > Open Folder จากนั้นเลือกโฟลเดอรที่เราไดสราง

เอาไว ซึ่งในที่นี้คือ C:\bvn\html5

 เมื+อเปดโฟลเดอรแลว ใหสรางไฟลใหมเพิม่เขามาในโฟลเดอรนัน้ โดย

คลกิไอคอนดงัในภาพ แลวกําหนดชื+อไฟลลงไป โดยใหมสีวนขยายเปน 

.html เชน ในทีก่าํหนดกําหนดชื+อเปน test.html (ตําแหนQงไฟลคอื C:\

bvn\html5\test.html)
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 ใหเราใชตัวชวยคือ Emmet Action ในการสรางเอกสาร โดยพิมพเครื+องหมาย ! ลงบน Editor เมื+อ

ปรากฏ IntelliSense ใหเลื+อนไฮไลตมาที่ ! Emmet Abbreviation แลวกด <Enter> หรือคลิกดวย

เมาส ซึ่งโครงสรางหลักของ HTML จะถูกใสลงไปโดยอัตโนมัติ

 ใหบันทึกการเปลี่ยนแปลง เชน กด <Ctrl + S> แลวคลิกขวาบน Editor ที่แสดงโคดของไฟล หรือ

คลิกขวาที่ชื+อไฟลก็ได จากนั้นเลือก Open with Live Server แลวไฟลของเว็บเพจดังกลาว จะถูก

เปดบนเว็บเบราวเซอรตัวที่ตั้งคาเปนดีฟอลตใหโดยอัตโนมัติ

   

ตอไปเมื+อเราแกไขโคดแลวบนัทกึการเปล่ียนแปลง Live Server จะอปัเดตการแสดงผลบนเว็บเบราวเซอร 

ใหสอดคลองกันทันที ซึ่งเราไมจําเปนตอง Refresh เบราวเซอรก็ได
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อยาลมืขอบงัคับของ Live Server น่ันคอื ตองเปดโฟลเดอรทีจ่ะเก็บไฟลขึน้มากอน แลวคอยเปดไฟลเปาหมาย  

จากนัน้จงึแสดงผลดวยเบราวเซอร ตามขัน้ตอนทีไ่ดกลาวมาแลวนัน่เอง หากเราเปดไฟลบน VS Code โดยตรง  

จะไมสามารถแสดงดวยเบราวเซอรได

หมายเหตุ

ลักษณะของแท็กและอิลิเมนต
องคประกอบตาง ๆ  ภายในเวบ็เพจ จะถกูกาํหนดดวยสญัลกัษณทีเ่รยีกวา แทก็ (Tag) เพื+อแสดงจดุเริม่ตน 

และจุดสิ้นสุด (หรือขอบเขต) ของเนื้อหาในแตละอยาง ดังรูปแบบตอไปนี้

<ชื+อแท็ก>เนื้อหา</ชื+อแท็ก>

เราสามารถสรุปลักษณะพื้นฐานที่สําคัญเกี่ยวกับแท็กของ HTML ไดดังนี้

 ชื+อแท็ก จะกําหนดระหวางเครื+องหมาย < และ > เชน <html> หรือ <title> เปนตน

 แท็กที่กําหนดไวที่จุดเริ่มตนของเนื้อหาจะเรียกวา Start Tag หรือ Open Tag

 แท็กทีก่าํหนดไวทีจ่ดุสิน้สดุของเนือ้หาจะเรยีกวา End Tag หรอื Close Tag ซึง่จะเขยีนเครื+องหมาย /  

ไวหนาชื+อแท็กดวย เชน </html>

 เมื+อรวมแทก็และเนือ้หาเขาดวยกนั เราจะเรยีกวา อิลเิมนต (Element) ดังนัน้ จงึกลาวไดวา อิลเิมนต 

ก็คือสิ่งที่อยูระหวาง Start Tag และ End Tag นั่นเอง

 คูแท็กเริ่มตนและสิ้นสุดตองเปนชื+ออันเดียวกัน เชน <body> กับ </body> หรือ <title> กับ </title>  

เปนตน

 แทก็ของ HTML ไมสนใจความแตกตางของตวัพมิพ เชน เราอาจเขยีนเปน <title> หรอื <TITLE> หรือ

ใชตัวพิมพเล็ก-ใหญปะปนอยางไรก็ได แตโดยทั่วไปนิยมเขียนแท็กดวยตัวพิมพแบบเดียวกันทั้งหมด

 ยงัมอีลิเิมนตอกีลกัษณะหนึง่ทีไ่มตองกําหนดเนือ้หาใหกบัมนั โดยจะเขยีนดวยแทก็เริม่ตนเพยีงอนัเดยีว  

ซึ่งอาจเรียกวาเปนอิลิเมนตแบบแท็กเดี่ยว (Single Tag) เชน <br>, <hr> เปนตน
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แอตทริบิวตของแท็ก
แอตทริบิวต (Attribute) หรือพร็อปเพอรตี้ (Property) เปนการกําหนดขอมูลบางอยางใหกับแท็กตาง ๆ  

เชน แท็กที่ใชแสดงรูปภาพ ก็จะมีแอตทริบิวตที่ใชกําหนดตําแหนQงภาพ หรือแท็กที่แสดงลิงก ก็จะมีแอตทริบิวต

ที่ใชกําหนด URL ปลายทางเมื+อคลิกที่ลิงก เปนตน ซึ่งการกําหนดแอตทริบิวตมี 2 ลักษณะ ดังนี้

 <name="value"> แอตทรบิวิตแบบน้ีจะกําหนดชื+อและคาของมันในรูปแบบ name="value" ทีแ่ทก็

เริ่มตน ในรูปแบบ

<ชื+อแท็ก attribute1="value" attribute2="value" attribute3="value" …>

<img src="rose.jpg" alt="rose">
<a href="http://www.developerthai.com" target="_blank">Go to...</a>

 <attribute_name> เรียกวา แอตทริบิวตแบบบูลีน (boolean) โดยทั่วไปเราจะกําหนดเพียงแค 

ชื+อแอตทริบิวต เพื+อบงชี้วาเราตองการใชงานแอตทริบิวตดังกลาวโดยไมระบุคา ซึ่งแอตทริบิวต 

ในกลุมนี้ เชน disabled, readonly, checked, selected, multiple เปนตน แนวทางการใชงานคือ

<input type="text" disabled>
<input type="checkbox" checked>

โครงสรางหลักของ HTML
โครงสรางหลักของเว็บเพจ จะกําหนดดวยแท็กตาง ๆ  ดังตอไปนี้

<!doctype html> ประกาศวาเปนเอกสารชนิด html

<html> กําหนดองคประกอบภายในเว็บเพจ นอกจากนี้ เราอาจระบุแอตทริบิวต lang เพื+อบงชี้

ภาษาที่ใชในการแสดงผล เชน <html lang="th">

<head> กําหนดองคประกอบในสวนหัวของเว็บเพจ

<body> กําหนดสวนเนื้อหาของเว็บเพจที่จะแสดงผล



บทที่ 1   23

ลักษณะการจัดวางแท็กเพื+อกําหนดโครงรางหลักของเพจ จะเปนดังนี้

<!doctype html>
<html lang="th">
<head>
 สวนหัวของเว็บเพจ (ดูแท็กกลุมนี้ในหัวขอถัดไป)
</head>
<body>
 เนื้อหาของเว็บเพจ

</body>
</html>

กลุมแท็กที่สวนหัวของเว็บเพจ
สวนหัวของเว็บเพจ จะกําหนดดวยแท็ก <head> แตเราจะไมระบุแอตทริบิวตใหกับมันโดยตรง เพราะ

มีแท็กที่ใชงานเฉพาะในแตละอยางอยูแลว โดยวางซอนไวใน <head> แตแท็กเหลานี้จะไมแสดงผลออกไปที่ 

เบราวเซอร ซึ่งอันที่นQาสนใจคือ

<title> กําหนดหัวขอหรือชื+อเว็บเพจ ซึ่งจะปรากฏบนแท็บของเบราวเซอร 

<meta charset="..."> กําหนดรหัสอักขระสําหรับเพจนั้น เชน <meta charset="UTF-8">

<meta name="viewport"> กําหนดขนาดความกวางของพื้นที่แสดงผล

<meta name="keywords"> กําหนดคียเวิรดที่มีในเพจนั้น เพื+อให Search Engine นําไปทําเปนดัชนี

การสืบคนขอมูล โดยใชแอตทริบิวต content สําหรับระบุคียเวิรด หากมี

มากกวา 1 คํา ใหคั่นแตละคําดวยเครื+องหมาย , เชน

<meta name="keywords" content="Bootstrap5,Vue,Node">

<meta name="description"> สําหรับเขียนคําอธิบายโดยสังเขปเกี่ยวกับเพจนั้น เพื+อให Search Engine 

นาํไปแสดงในผลลัพธของการสบืคน โดยใหเขยีนคาํอธบิายดวยแอตทริบวิต 

content เชน 

<meta name="description" content="HTML5 is Hyper ...">

<meta http-equiv="..."> สาํหรบักาํหนด Http Header ของเว็บเพจ เพื+อใหเบราวเซอรนาํไปพจิารณา

รูปแบบการตอบสนอง

<base href="..."> กําหนดสวนเริ่มตนของ URL ที่มักอางถึงบอย ๆ  ในเพจน้ัน
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นอกจากนี้ ยังมีแท็กอีกบางสวนที่ตองกําหนดไวที่สวนหัวของเว็บเพจ เชน แท็กเกี่ยวกับ CSS หรือ 

JavaScript เปนตน ซึ่งจะนําไปกลาวถึงในเรื+องที่เกี่ยวของตอไป และสําหรับบางแท็กที่แสดงในตารางที่ผานมา  

มีรายละเอียดเพิ่มเติม ดังนี้

 viewport เปนขนาดพื้นที่ในการแสดงผลเว็บเพจ เนื+องจากขนาดหนาจอของอุปกรณ (Device) ที่ใช 

เปดดเูวบ็อาจแตกตางกนัออกไป เชน ในคอมพิวเตอรจะมีขนาดใหญกวามอืถอื เปนตน ดงันัน้ เราสามารถ 

กําหนด viewport ใหขึ้นกับอุปกรณ เชน

<meta name="viewport" content="width=device-width, initial-scale=1.0">

 ๏ width=device-width หมายถึง ใหพื้นที่การแสดงผลขึ้นกับขนาดความกวางของอุปกรณ

 ๏ initial-scale=1.0 หมายถึง ใหอัตราสวนการขยายขนาด (zoom) เทากับ 1.0 

 http-equiv ลักษณะการใชงานที่เราพบเห็นไดบอย ๆ  คือ 

 ๏ ใหเบราวเซอรโหลดเพจนัน้มาแสดงใหมในทกุชวงเวลาทีก่าํหนด (วนิาท)ี เชน ในโคดถดัไป หมายถงึ 

ใหโหลดเพจทุก 30 วินาที

<meta http-equiv="refresh" content="30">

 ๏ หรอือาจใหเบราวเซอรยายไปแสดงผลทีเ่พจหรอื URL ทีร่ะบ ุเมื+อครบเวลา (วนิาท)ี ทีก่าํหนดหลงั

จากโหลดเพจนั้น เชน ในโคดถัดไปหมายถึง หลังจากโหลดเพจนี้แลว ใหจับเวลาไปอีก 5 วินาที 

แลวยายไปยัง http://www.example.com

<meta http-equiv="refresh" content="5;http://www.example.com">

 ๏ นอกจากน้ี ยงัใชกาํหนดเวอรชนัของเว็บเบราวเซอรทีจ่ะยดึเปนเกณฑในการแสดงผล เชน ในโคด 

ถดัไป หมายถงึ ถาเวบ็เพจนีถ้กูเปดดวย IE ใหแสดงผลตามขอกาํหนดของเวอรชนัลาสดุในขณะนัน้  

เปนตน

<meta http-equiv="X-UA-Compatible" content="IE=edge">

 <base> มักใชเมื+อเราตองเขยีน URL ทีย่าว ๆ  อยูบอย ๆ  ซึง่หากเรานาํสวนเร่ิมตนมากาํหนดดวยแทก็ 

<base> แลวตอไป ถาตองการอางถึง URL ดังกลาว ก็สามารถกําหนดเฉพาะสวนที่อยูตอจาก base 

ไดเลย อยางไรก็ตาม ในแตละเพจ จะมีแท็ก <base> ไดเพียงอันเดียวเทานั้น เชน สมมติวาโดย

ปกติเราตองกําหนดตําแหนQง URL ของหลาย ๆ  ภาพและลิงกซํ้ากันในลักษณะดังนี้
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<img src="http://www.developerthai.com/img/logo.png">
<img src="http://www.developerthai.com/img/nature/flower.jpg">

เราสามารถนํา URL สวนทีต่องอางถึงซํา้ ๆ  กัน ไปกาํหนดดวยแท็ก <base> ไวทีส่วนหวั (head) ของเพจ  

แลวตอไปก็สามารถอาง URL เฉพาะสวนที่อยูตอจาก base ไดเลย แต URL ที่ไมไดอยูที่เดียวกับ 

base ตองระบุแบบเต็ม ๆ  ตามปกติ เชน

...
<head>
 <base href="http://www.developerthai.com/img/">
</head>
<body>
 <img src="logo.png">
 <img src="nature/flower.jpg">
</body>

 แท็ก <base> ยังมีอีกหนึ่งแอตทริบิวตคือ target ซึ่งมักใชในกรณีที่เราตองการใหเปดเพจเปาหมาย

บนแท็บใหม โดยกําหนดคาแอตทริบิวตนี้เปน "_blank" เชน 

<base href="http://www.example.com" target="_blank">

การกําหนดภาพ Favicon
Favicon (มาจากคาํวา Favorite icon) เปนภาพไอคอนขนาดเล็ก ซึง่มักใชเพื+อแสดงความเปนเอกลกัษณ

ของเว็บไซตแหงนั้น เชน ภาพโลโก เปนตน โดยจะถูกนํามาแสดงที่แท็บของเบราวเซอรรวมกับไตเติลของเพจ

นั้น ในลักษณะดังภาพตอไปนี้
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สําหรับแนวทางการสรางภาพ Favicon มีดังนี้

 สําหรับภาพ Favicon สวนใหญนิยมกําหนดใหมีขนาด 16 × 16 ปจจุบันเราสามารถใชภาพไดหลาย

ชนิด เชน gif, png, svg เปนตน

 วิธีการนําภาพ Favicon มาใชงานคือ ใหกําหนดผานแท็ก <link> ในรูปแบบ

<link rel="icon" href="ชื+อภาพ" type="...">

 แท็ก <link> ตองวางไวระหวาง <head>...</head> เชน

<head>
  ...
 <link rel="icon" href="favicon.gif" type="image/gif">
 <!-- 
 <link rel="icon" href="favicon.svg" type="image/svg+xml">
 -->
</head>

กลุมแท็กสําหรับจัดแบงเนื้อหา
ในกรณีที่เราตองการจัดแบงขอบเขตของเนื้อหา เชน การขึ้นบรรทัดใหม การขึ้นยอหนา หรือการแบง

กลุมขอความเพื+อการจัดรูปแบบเฉพาะ ก็สามารถกําหนดดวยแท็กตอไปนี้

<br> ใชกําหนดจุดสิ้นสุด (Break) เพื+อขึ้นบรรทัดใหม แท็กนี้เปนแบบ Single Tag

<p> สําหรับการขึ้นยอหนาใหม โดยกําหนดขอความไวระหวางแท็กเปด <p> และแท็กปด </p> แลว

ขอความนั้นจะถูกนําไปขึ้นบรรทัดใหม โดยเวนระยะหางพอประมาณ

<span> ใชจัดกลุมเนื้อหาภายในบรรทัด (inline) โดยเนื้อหาที่อยูใน <span> สามารถรวมอยูในบรรทัด

เดียวกันกับเนื้อหาที่อยูนอก <span> ได

<div> ใชจัดกลุมเนื้อหาแบบบล็อก (block) โดยเนื้อหาที่อยูใน <div> ไมสามารถรวมอยูในบรรทัด

เดียวกันกับเนื้อหาที่นอก <div> ได แตจะถูกแยกออกไปอยูบรรทัดใหม

<hr> สําหรับแสดงเสนแบงในแนวนอน (Horizontal Rule) แท็กนี้เปนแบบ Single Tag
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แนวทางการใชงาน เชน

bvn/html5/text-block.html

...
<body>
    <span>Using p:</span><br>
    <p>First p: Lorem ipsum dolor sit amet consectetur ...</p>
    <p>Second p: Eos doloremque aliquam laboriosam nisi ...</p>
    <hr>
    <span>Using: div</span><br>
    <div>First div: Lorem ipsum dolor sit amet consectetur ...</div>
    <div>Second div: Eos doloremque aliquam laboriosam nisi ...</div>
    <hr>
    <span>Using: span</span><br>
    <span>First span: Lorem ipsum dolor sit amet consectetur ...</span>
    <span>Second span: Eos doloremque aliquam laboriosam nisi ...</span>
</body>

จากภาพผลลัพธจะเห็นไดวา กรณีของ <p> จะแบงยอหนาโดยขึ้นบรรทัดใหมพรอมเวนบรรทัดวางระยะ

ระหวางยอหนา สวน <div> จะขึ้นบรรทัดใหมแตไมเวนบรรทัดวาง สวน <span> จะเขียนตอเนื+องในบรรทัด 

เดียวกัน
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กลุมแท็กสําหรับจัดรูปแบบขอความ
การจัดรูปแบบขอความ เชน ทําตัวหนา ตัวเอียง ขีดเสนใต เปนตน โดยมีแท็กที่นQาสนใจ ซึ่งเรามักนํา

ไปใชงานอยูบอย ๆ  คือ

<b> สําหรับทําตัวหนา (bold)

<h1>, <h2>, ... <h6> กําหนดขนาดหัวขอโดย <h1> จะใหญสุดแลวลดลงตามลําดับ

<i> สําหรับทําตัวเอียง (italic)

<u> สําหรับขีดเสนใต (underline)

<s> หรือ <del> สําหรับขีดเสนทับขอความ 

<mark> ทําแถบสีพื้นหลังขอความ (ปกติจะเปนสีเหลือง)

<sub> สําหรับทําตัวหอย (subscript) เชน O2

<sup> สําหรับทําตัวยก (superscript) เชน e = mc
2

<pre> จัดรูปแบบขอความตามที่เขียนในโคด (pre-format)

แนวทางการใชงาน เชน

bvn/html5/text-format.html

...
<body>
 <p><b>ขอความนี้เปนตัวหนา (bold)</b></p>
 <p><i>ขอความนี้เปนตัวเอียง (italic)</i></p>
 <p><u>ขอความนี้ขีดเสนใต (underline)</u></p>
 <p><del>ขอความนี้ถูกขีดทับ (delete)</del></p>
 <p>ขอความนี้ม<ีsub>ตัวหอย</sub> (subscript)</p>
 <p>ขอความนี้ม<ีsup>ตัวยก</sup> (superscript)</p>
  <p><mark>ขอความนี้ทําแถบส ี(mark)</mark></p>
 <h1>ขอความขนาด h1</h1>
 <h3>ขอความขนาด h3</h3>
 <h5>ขอความขนาด h5</h5>  
 <pre>
 บรรทัดที่ 1
 บรรทัดที ่2
 บรรทัดที ่3
    </pre> 
</body>
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แท็กสําหรับแสดงคําอธิบาย
กรณทีีเ่ราตองการเขยีนคําอธบิาย (Comment) ลงในโคด ใหกาํหนดดวยแทก็ <!-- … --> โดยเวบ็เบราวเซอร 

จะไมนําคําอธิบายนี้ไปประมวลผล และไมแสดงออกมาที่หนาเว็บเพจใหเห็น หรืออาจเขียนครอบคําสั่ง HTML 

เพื+อไมใหเว็บเบราวเซอรประมวลคําสั่งนั้นก็ได เชน

<body>
  <!-- เริ่มตนบทความ -->
 <div>
   Lorem ipsum dolor sit amet, <br>
   consectetur adipiscing elit,
   ...
 </div>
 <!-- สิ้นสุดบทความ -->
 <!-- &copy;2022 developerthai.com -->
</body>

อักขระพิเศษของ HTML
อักขระบางตัว ถูกนํามาใชสําหรับการกําหนดแท็ก HTML เชน เครื+องหมาย < หรือ > และนอกจากนี้

อักขระอีกบางสวนก็ไมมีอยูบนคียบอรด จึงไมสามารถเขียนอักขระลงไปโดยตรงได แตตองแทนดวยสัญลักษณ

พิเศษ ซึ่งอันที่นQาสนใจคือ

ชองวาง &nbsp; (แทนชองวาง 1 ชอง) x &times; (คูณ)

< &lt; (มาจาก less than) ± &plusmn;

> &gt; (มาจาก greater than) · &middot; (จุดกลางบรรทัด)

" &quot; £ &pound;

' &apos; € &euro;

& &amp; ¥ &yen;

© &copy; (มาจาก copyrights) « &laquo;

® &reg;  (มาจาก registered) » &raquo;

÷ &divide; é &eacute;
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 ถาเวนชองวางเพยีงอนัเดยีว เราสามารถใสชองวางลงไปในโคดโดยตรงไดเลย แตถาเวนมากกวา 1 ชอง  

เราตองแทนดวยสญัลกัษณ &nbsp; ตามจาํนวนชองวางทีต่องการ ทัง้นีห้ากเวนชองหลายชองในโคด

โดยตรง เบราวเซอรจะแสดงชองวางเพียงอันเดียว

 สําหรับอักขระ >, <, ", ' และ & หากใชในการเขียนแบบขอความทั่วไปที่ไมใชแท็ก HTML สามารถ

เขียนลงไปโดยตรงไดเลย เชน เลือกสินคา > หยิบใสรถเข็น > ชําระเงิน แตถาจะนําไปเขียนรวมกับ

แทก็ HTML และตองการใหเบราวเซอรแสดงอกัขระนัน้ออกมา จะตองเขยีนในแบบสญัลกัษณดงักลาว 

มาแลว เชน แท็ก <bold> ก็เขียนแทนดวย &lt;bold&gt;

bvn/html5/special-chars.html

...
<body>
 <p>
  เวนชองวาง 1 ชอง<br>
  เวนชองวาง 1&nbsp;ชอง<br>
  เวนชองวาง 5 ชอง<br>
  เวนชองวาง 5&nbsp;&nbsp;&nbsp;&nbsp;&nbsp;ชอง

 </p>
 <p>
  แท็ก &lt;p&gt; ใชเมื+อตองการขึ้นยอหนาใหม<br>
  และ &lt;div&gt; ใชสําหรับแสดงผลแบบบล็อก

 </p>
 <br>
 &copy; 2022 developerthai.com
</body>

แท็กสําหรับแสดงรายการ
ลาํดบัรายการ (List) ก็คอืการแบงขอมลูเปนขอยอย ๆ  ซึง่เราสามารถกาํหนดรปูแบบ 

การจัดเรียงได 2 ประเภทคือ

 Unordered List เปนการจัดเรียงรายการที่ไมเปนลําดับตอเนื+อง โดยใช

สัญลักษณ เชน วงกลมหรือสี่เหลี่ยมขนาดเล็ก วางไวหนารายการ

 Ordered List เปนการจัดเรียงรายการที่มีลําดับตอเนื+องโดยใชตัวเลขหรือ

อักขระ เชน 1, 2, 3, ... หรือ a, b, c, ... วางไวหนารายการ
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สําหรับแท็กที่เกี่ยวของกับการกําหนดลําดับรายการ มีดังนี้

<ul type="..."> กําหนดขอบเขตของรายการแบบ Unordered List โดยแอตทริบิวต type ใช

กําหนดสัญลักษณหนารายการ ดวยคาใดคาหนึ่งดังนี้

 disc วงกลมทึบ (คาดีฟอลต)

 circle วงกลมกลวง

 square สี่เหลี่ยม 

<ol type="..." start="..."> กําหนดขอบเขตของรายการแบบ Ordered List โดยแอตทริบิวต type คือ

อักขระที่แสดงลําดับหนารายการ ใหกําหนดคาใดคาหนึ่งดังนี้

 "1" เปนแบบตัวเลข เชน 1, 2, 3

 "a" เปนตัวอักษรภาษาอังกฤษแบบพิมพเล็ก เชน a, b, c, ...

 "A" เปนตัวอักษรภาษาอังกฤษแบบพิมพใหญ เชน A, B, C, ...

 "i" ตัวเลขโรมันแบบพิมพเล็ก เชน i, ii, iii, ...

 "I" ตัวเลขโรมันแบบพิมพใหญ เชน I, II, III, ...

สวนแอตทริบิวต start ใชกําหนดลําดับเริ่มตน (ถาไมระบุจะเริ่มจากตัวแรกสุด

ของลําดับในกลุมนั้น หรือตามคาของแอตทริบิวต type นั่นเอง)

<li> ใชกําหนดรายการทั้งแบบ Unordered และ Ordered List

แนวทางการกําหนดรายการแบบ Unordered List มีดังนี้

bvn/html5/unordered-list.html

...
<body>
 <h5>Unordered list type: disc</h5>
 <ul type="disc">
  <li>Apple</li>
  <li>Banana</li>
  <li>Coconut</li>
 </ul>
 <h5>Unordered list type: square</h5>
 <ul type="square">
  <li>Rose</li>
  <li>Orchid</li>
  <li>Jasmine</li>
 </ul>
 <h5>Unordered list type: circle</h5>
 <ul type="circle">
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bvn/html5/unordered-list.html (ตอ)

  <li>Red</li>
  <li>Geen</li>
  <li>Blue</li>
 </ul>
 <h5>Combine unordered list</h5>
 <ul type="disc">
  <li>disc</li>
  <li type="circle">circle</li>
  <li type="square">square</li>
 </ul>
 <h5>Nest unordered list</h5>
 <ul>
  <li>Fruit</li>
  <ul>
   <li>Apple</li>
   <li>Orange</li>
  </ul>
  <li>Flower</li>
  <ul>
   <li>Rose</li>
   <li>Orchid</li>
  </ul>
 </ul>
</body>

แนวทางการกําหนดรายการแบบ Ordered List มีดังนี้

bvn/html5/ordered-list.html

...
<body>
 <h5>Ordered List แบบ decimal:</h5>
 <ol type="1">
  <li>One</li>
  <li>Two</li>
  <li>Three</li>
 </ol>
 <h5>Ordered List แบบ decimal เริ่มตนที่ 2022:</h5>
 <ol type="1" start="2022">
  <li>กอตั้งบริษัท</li>
  <li>จดทะเบียนในตลาดหลักทรัพย</li>
  <li>เลิกกิจการ</li>
 </ol>
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bvn/html5/ordered-list.html (ตอ)

 <h5>Ordered List แบบ lower-alpha:</h5>
 <ol type="a">
  <li>ant</li>
  <li>boy</li>s
  <li>cat</li>
 </ol>
 <h5>Ordered List แบบ upper-alpha เริ่มตนที ่4:</h5>
 <ol type="A" start="4"> <!-- A=1, B=2, 
                              C=3, D=4, ... -->
  <li>Dog</li>
  <li>Egg</li>
  <li>Fox</li>
 </ol>   
</body>

การเชืXอมโยงดวยลิงก
การเชื+อมโยงดวยลิงก (Link) มีหลายลักษณะ เชน การเชื+อมโยงระหวางเพจทั้งที่อยูในเว็บไซตเดียวกัน

และเวบ็ไซตอื+น ๆ  รวมถงึการเชื+อมโยงสาํหรบัดาวนโหลดไฟล เปนตน โดยจะกาํหนดดวยแทก็ <a> ในลกัษณะดงันี้

<a href="..." target="...">ขอความที่แสดงเปนลิงก</a>

โดยการกําหนดแอตทริบิวตจะขึ้นกับลักษณะการเชื+อมโยง ซึ่งแบงเปนกรณียอย ๆ  คือ

<a href="url" target="..."> สําหรับเชื+อมโยงไปเพจอื+น ๆ  โดยระบุ URL ของเพจปลายทาง เชน  

<a href="http://developerthai.com">Go</a>

หรือถาเพจนั้นอยูในเว็บไซตเดียวกัน ก็อาจระบุแคตําแหนQงไฟล เชน 

<a href="member/signin.html">เขาสูระบบ</a>

สวนแอตทริบิวต target ใชกําหนดวินโดวเปาหมายที่จะเปดลิงกนั้น ดวยคา

ใดคาหนึ่งดังนี้

 _blank เปดในวินโดวหรือแท็บใหม

 _self เปดในวินโดวปจจุบัน

 _top มักใชในกรณีที่แสดงเพจในเฟรม แลวตองการเปดเพจนั้นในวินโดว

ปจจุบันแบบเต็มเพจ หรือยกเลิกเฟรมนั่นเอง
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<a href="mailto:"> สรางลงิกเพื+อสงอเีมล โดยเมื+อคลกิทีล่งิก จะเปดแอปสาํหรบัการสงเมล เชน 

<a href="mailto:admin@example.com">Send Mail</a>

<a href="file_url"> สรางลงิกสาํหรบัการดาวนโหลดไฟล ซ่ึงหากอยูบนเวบ็ไซตอื+น ตองระบุ URL 

แบบเต็ม แตถาอยูบนเว็บไซตของเราเอง อาจระบุแคตําแหนQงไฟลก็ได เชน 

<a href="ht tp : / /example .com/code.z ip">Download</a> 

<a href="html5/code.zip">Download Code</a>

นอกจากนี ้ยงัสามารถสรางลงิกเพื+อเลื+อนไปยังหวัขอทีต่องการภายในเพจนัน้ ซึง่เรามกัจะสรางลงิกแบบนี ้

กับเพจท่ีมีเนื้อหาคอนขางยาว และยุงยากตอการเลื+อนหาขอมูล โดยการเชื+อมโยงดังกลาวจะชวยใหเราเขาถึง

ขอมูลเปาหมายไดเร็วขึ้น ดังหลักการตอไปนี้

1. การสรางลงิกเพื+อเชื+อมโยงไปยงัเปาหมายทีไ่ดจดัเตรียมเอาไว โดยใชแทก็ <a> เหมือนการสรางลงิก

ตามปกติ แตกําหนดคาแอตทริบิวต href ในแบบ <a href="#id">

2. กาํหนดเปาหมายของการเชื+อมโยง ซึง่เปนจุดทีเ่ราจะเลื+อนไปเมื+อคลกิทีล่งิกในขอ 1 โดยวางแทก็ <a> 

พรอมกําหนดแอตทริบิวต id เปนชื+อจุดเชื+อมโยงของตําแหนQงนั้น

bvn/html5/internal-link.html

...
<body>
 <a href="#html">HTML</a> -
 <a href="#css">CSS</a> - 
 <a href="#js">JavaScript</a>
 <hr><br><br><br><br><br><br>
 <a id="html"></a>
 <h4>HTML</h4>
 <p>HyperText Markup Language(HTML) is the main markup ...</p> 
 <a id="css"></a>
 <h4>CSS</h4>
 <p>Cascading Style Sheets(CSS) is a style sheet language ...</p>
 <a id="javascript"></a>
 <h4>JavaScript</h4>
 <p>JavaScript is a programming language for the web ...</p>
</body>

นอกจากการสรางลิงกในลักษณะดังที่กลาวมาทั้งหมดแลว ยังมีเทคนิคอื+น ๆ  เกี่ยวกับลิงกที่เราควรรูจัก

เพิ่มเติม ดังตอไปนี้
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 บางครัง้ ลงิกทีเ่ราสรางขึน้อาจยงัไมพรอมใชงาน กใ็หระบคุาของแอตทริบวิต href เปนเครื+องหมาย #  

ซึ่งเมื+อคลิกที่ลิงก จะยังอยูที่เพจเดิม เชน

<a href="#">ประกาศรายชื+อผูโชคด<ี/a>

 เราอาจใชรูปภาพเปนลิงกแทนขอความ โดยวางแท็ก <img> ซอนในแท็ก <a> เชน

<a href="http://www.developerthai.com"><img src="logo.png"></a>

 เราสามารถใชแท็ก <a> ในการสรางลิงกเพื+อเรียก JavaScript ขึ้นมาทํางานได โดยระบุคําสั่ง 

JavaScript ใหเปนคาของแอตทริบิวต href เชน

<a href="javascript: alert('Hello')">Test</a>

การแสดงรูปภาพบนเว็บเพจ
การแสดงภาพบนเว็บเพจนั้น เราจะกําหนดดวยแท็ก <img> ซึ่งเปนประเภท Single Tag คือมีเฉพาะ 

Start Tag โดยมีแอตทริบิวตที่สําคัญคือ

<img  src="ชื+อภาพ" 
   alt="ขอความที่จะแสดงแทนภาพเมื+อเกิดขอผิดพลาดในการโหลด" 
   title="ขอความแบบ tooltip เมื+อนําเมาสมาวางเหนือภาพ"
   width="ความกวาง" height="ความสูง"
>

สําหรับแท็ก <img> อยางนอยตองกําหนดแอตทริบิวต src เพื+อระบุชื+อภาพ ทั้งนี้หากภาพอยูในเว็บไซต

เดียวกัน เราอาจกําหนดแคชื+อ (รวมถึงพาธ) ของมัน เชน

<img src="images/logo.png" alt="logo" title="logo">

แตหากอยูบนเว็บไซตอื+น ๆ  ตองระบุ URL แบบเต็ม (หรือแมจะอยูในเว็บไซตเดียวกันก็ใชวิธีนี้ได) เชน

<img src="http://www.example.com/logo.png" alt="logo" title="logo">



36 พัฒนา Web App แบบ Responsive ดวย Bootstrap5 รวมกับ Vue.js และ Node.js

การเลนไฟลมัลติมีเดียบนเว็บเพจ
ใน HTML5 มีแท็ก <video> สําหรับใชเลนไฟลประเภทวิดีโอโดยตรง แตชนิดของไฟลที่เว็บเบราวเซอร

รองรับครบทุกตัวคือ mp4 เทานั้น ซึ่งแท็ก <video> มีแอตทริบิวตที่สําคัญดังนี้

<video src="ชื+อไฟล" width="ความกวาง" height="ความสูง" 
    preload="none | auto | metadata"
    controls   (กําหนดเมื+อตองการแสดงปุมควบคุมการเลนวิดีโอ)
    loop   (กําหนดเมื+อตองการเลนไฟลซํ้า)
    autoplay   (กําหนดเมื+อตองการเริ่มเลนไฟลโดยอัตโนมัติ)
    muted   (กําหนดเมื+อไมตองการใหมีเสียง)
>

 แอตทริบิวตที่ตองมีเสมอคือ src สวนแอตทริบิวตอื+น ๆ  ขึ้นกับความตองการของเราเอง

 แอตทริบวิตทีเ่ปนแบบบลูนี หากเราตองการกาํหนดใหมแีอตทรบิวิตนัน้ กใ็หระบชุื+อแอตทรบิวิตนีล้งไป  

โดยไมตองกําหนดคา เชน <video src="video.mp4" controls loop autoplay> 

 แอตทริบิวต preload กําหนดคาได 3 อยางคือ

 ๏ none ไมโหลดวิดีโอลวงหนา จนกวาผูใชจะคลิกปุมเริ่มเลน

 ๏ auto โหลดวิดีโอไวลวงหนาทันที (คาดีฟอลต)

 ๏ metadata โหลดเฉพาะขอมลูเก่ียวกบัวดิโีอ เชน ขนาดความกวาง × สงู, เฟรมแรก หรอืความยาว 

(เวลา) เปนตน

 แอตทริบิวต preload ถือเปนทางเลือกสําหรับกรณีที่เราไมกําหนด autoplay แตถาเรากําหนด

แอตทริบิวต autoplay แลว ไมตองกําหนดแอตทริบิวตนี้อีก

bvn/html5/video.html

...
<body>
 <h3>เลนไฟล video</h3>
 <video src="big-buck-bunny.mp4" width="320" height="240" 
  preload="auto" controls loop
 >
 </video>
</body>
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สวนกรณีของการเลนไฟลประเภทเสียง ก็มีแท็กใหใชงานโดยตรงคือ <audio> ซึ่งชนิดของไฟลที่รองรับ

ไดแก MP3, Wave และ Ogg โดยแอตทริบิวตที่สําคัญของแท็ก <audio> เชน src, controls, loop, autoplay, 

preload, muted ก็มีรายละเอียดเชนเดียวกับแท็ก <video>

bvn/html5/audio.html

...
<body>
 <h3>เลนไฟล audio</h3>
 <audio src="beat.mp3" preload="auto" controls></audio>
</body>

การสรางตาราง
ตาราง (Table) ใชในการจัดโครงรางและเนื้อหาของเพจมา  

ใหเปนระเบยีบเรยีบรอยและสวยงาม โดยแทก็ทีเ่กีย่วของกบัการสราง

ตารางมีดังนี้

<table> ใชกําหนดขอบเขตของตาราง <caption> ใชกําหนดปายชื+อตาราง

<thead> ใชกําหนดสวนหัวตาราง <tr> กําหนดแถวของตาราง

<tbody> ใชกําหนดสวนขอมูลของตาราง <th> ใชกําหนดเซลลหัวตาราง

<tfoot> ใชกําหนดสวนลางของตาราง <td> กําหนดชองเซลลของตาราง

แนวทางการสรางตารางแบบงาย ๆ  เพื+อแสดงขอมูลบางสวนเกี่ยวกับสินคา โดยใชแท็กเทาที่จําเปนกัน

ไปกอน เชน

bvn/html5/table1.html

...
<body>
 <table border="1">
  <caption>รายการสินคา</caption>
  <tr><th>Product</th><th>Price</th><td>Spec</th></tr>
  <tr><td>iPhone</td><td>40,000</td><td>6.4", 64BG, Red</td></tr>
  <tr><td>iPad</td><td>3,2000</td><td>11", 256GB, Silver</td></tr>
  <tr>
   <td>MacBook Pro</td>
   <td>100,000</td> 
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bvn/html5/table1.html (ตอ)

   <td>15", 512GB, Core i7, Space Gray</td> 
  </tr>
 </table>
</body>

ตารางนี้กําหนดขนาดเสนขอบ (แอตทริบิวต border) ใหเปน 1 เพื+อใหเห็นแนวการแบงแถวและคอลัมน

ที่ชัดเจนขึ้น โดยแอตทริบิวต border ตองใชกับแท็ก <table> เทานั้น

นอกจากนี้ เรายังสามารถจัดแบงกลุมแถวของตารางดวยแท็กดังตอไปนี้

 แท็ก <thead> สําหรับกําหนดกลุมแถวที่เปนสวนหัว 

ของตาราง

 แท็ก <tbody> สําหรับกําหนดกลุมแถวที่เปนสวนขอมูล

ของตาราง

 แท็ก <tfoot> สําหรับกําหนดกลุมแถวที่เปนสวนลาง 

ของตาราง

ในแตละกลุม จะมีจํานวนกี่แถวก็ได และไมจําเปนตองแบงครบทุกกลุม เชน อาจมีเพียงกลุม <thread> 

และ / หรือ <tbody> เปนตน ซึ่งลักษณะการนําไปใชงาน เชน จากตารางในโคดที่ผานมา หากเราตองการจัด

กลุม ก็อาจแกไขเปนดังนี้

bvn/html5/table2.html

...
<body>
<table border="1">
 <caption>รายการสินคา</caption>
 <thead>
  <tr><th>Product</th><th>Price</th><th>Spec</th></tr>
 </thead>
 <tbody>
  <tr><td>iPhone</td><td>40,000</td><td>6.4", ...d</td></tr>
  ...
 </tbody>
 </table>
</body>

แมผลลัพธที่ไดจะไมแตกตางจากการไมจัดกลุมแถวเลย แตในบางกรณี เชน การใชรวมกับ Bootstrap 

เราจําเปนตองจัดกลุมแถวของตาราง เพื+อกําหนดรูปแบบเฉพาะในแตละกลุม ดังที่จะกลาวถึงในบทตอ ๆ  ไป



2
C

 SS (Cascading Style Sheets) เปนคําสั่งที่ใชในการจัดรูปแบบเอกสารเว็บเพจในลักษณะตาง ๆ  เชน  

 ส ีพืน้หลงั เสนขอบ ขนาด โครงราง หรือตวัอกัษร เปนตน แมวาใน HTML นัน้จะมทีัง้แทก็และแอตทรบิวิต

บางสวนที่สามารถใชจัดรูปแบบเอกสารอยูแลว แตไมครอบคลุมการใชงานครบทุกกรณี นอกจากนี้ก็ยังขาด 

ความยืดหยุนและไมสามารถจัดรูปแบบในลักษณะที่ซับซอนได ซึ่งในปจจุบันเราจะเนนการจัดรูปแบบดวย CSS 

มากกวาทีจ่ะใชแทก็และแอตทรบิวิตของ HTML ดงันัน้ จงึเกดิการแยกหนาทีก่นัอยางชดัเจนคอื HTML ใชสาํหรบั 

การจัดโครงรางของเว็บเพจ สวน CSS ใชสําหรับการจัดรูปแบบของเว็บเพจ สําหรับบทนี้เราจะไดศึกษาการจัด

รปูแบบเอกสารดวย CSS ทีส่าํคัญในเบ้ืองตน เพื+อเปนพืน้ฐานไปสูการใช Bootstrap ท่ีจะกลาวถงึในบทตอ ๆ  ไป

พร็อปเพอรตี้ของ CSS
พร็อปเพอรตี ้(Property) ของ CSS คอืสิง่ทีใ่ชกาํหนดคณุลกัษณะตาง ๆ  ของอลิเิมนต HTML เชน ทาํให

ขอความเปนสฟีา + พืน้หลงัเปนสเีหลอืง หรอืทาํใหฟอนตมขีนาดตามท่ีตองการ เปนตน สําหรบัหลกัการเบือ้งตน 

เกี่ยวกับพร็อปเพอรตี้ที่เราควรทราบ มีดังนี้

การกําหนดคาของพร็อปเพอรตี้
รูปแบบการกําหนดคาของพร็อปเพอรตี้จะมี 2 สวนคือ ชื+อพร็อปเพอรตี้ และคาของมัน โดยคั่นระหวาง

ชื+อและคาดวยเครื+องหมาย Colon (:) คือ

ชื+อพร็อปเพอรตี:้ คาที่กําหนด

พื้นฐานที่สําคัญ 
ของ CSS3
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กรณีที่มีมากกวา 1 พร็อปเพอรตี้ ใหคั่นแตละพร็อปเพอรตี้ดวยเครื+องหมาย Semicolon (;) ในรูปแบบ

ดังตอไปนี้

พร็อปเพอรตี-้1: คาที่กําหนด; พร็อปเพอรตี-้2: คาที่กําหนด; พร็อปเพอรตี-้3: คาที่กําหนด; ...

แนวทางการกําหนดพร็อปเพอรตี้ เชน

color: white; background-color: black; font-size: 12pt;

ถาเราไมเขยีนรวมไวในบรรทดัเดยีวกนั เราอาจเขยีนแยกกนัไวคนละบรรทดักนักไ็ด เนื+องจากมีเครื+องหมาย ;  

คั่นระหวางพร็อปเพอรตี้อยูแลว เชน

color: white; 
background-color: black; 
font-size: 12pt;

พร็อปเพอรตี้พื้นฐานที่ควรรูจัก
ใน CSS นั้น มีพร็อปเพอรตี้ที่ใชกําหนดรูปแบบเปนจํานวนมาก ซึ่งเราจะไดศึกษาตอเนื+องกันไปเรื+อย ๆ  

แตในหัวขอนี้ เราควรรูจักกับพร็อปเพอรตี้พื้นฐานบางสวนของ CSS ลวงหนาไวกอน เพื+อใชประกอบการศึกษา

รวมกับหัวขอในชวงแรก ๆ  ของบทนี้ นั่นคือ

color กาํหนดสขีอความ โดยในเบือ้งตนใหระบคุาเปนชื+อสใีนภาษาองักฤษไปกอน เชน green, 

blue, red, yellow, black, white, gray, pink, brown, orange เปนตน

background-color กําหนดสีพื้นหลัง โดยระบุคาเปนชื+อสีเชนเดียวกับ color

font-size กาํหนดขนาดของฟอนต ซึง่ในเบือ้งตนใหกาํหนดคาเปนตวัเลข ตามดวยหนQวย pt หรือ 

px โดยตัวเลขและหนQวยใหเขียนติดกัน เชน font-size: 10pt หรือ font-size: 12px 

font-weight กําหนดขนาดนํ้าหนักของฟอนต มักใชเมื+อตองการทําใหขอความเปนตัวหนา โดยระบุ

คาเปน bold เชน font-weight: bold

font-style กําหนดรูปแบบฟอนต โดยทั่วไปมักกําหนดเมื+อตองการทําใหขอความเปนตัวเอียง 

โดยระบุคา italic เชน font-style: italic

text-decoration สําหรับตกแตงขอความ มักใชเมื+อตองการขีดเสนใต โดยระบุคาเปน underline เชน 

text-decoration: underline
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ขอบเขตของการกําหนดสไตลแบบตาง ๆ
การกําหนดสไตลแบงออกเปน 3 แบบ คือ

 สไตลแบบ Inline จะมีผลเฉพาะกับอิลิเมนตที่กําหนดสไตลใหกับมัน

 สไตลแบบ Internal จะมีผลกับทุกอิลิเมนตภายในเพจนั้น ที่ตรงกับขอกําหนด

 สไตลแบบ External นําเขาสไตลจากไฟลภายนอก และจะมีผลกับทุกอิลิเมนตภายในเพจนั้น ที่ตรง

กับขอกําหนด

สําหรับรายละเอียดการกําหนดสไตลแตละแบบมีดังตอไปนี้

การกําหนดสไตลแบบ Inline
สไตลแบบ Inline คือการกาํหนดรปูแบบเอาไวทีแ่ทก็ซึง่เราตองการจดัรปูแบบ โดยระบพุรอ็ปเพอรตีแ้ละ

คาของมันใหกับแอตทริบิวต style ซึ่งรูปแบบคือ

<แท็ก style="พร็อปเพอรตี-้1: คาที่กําหนด; พร็อปเพอรตี-้2: คาที่กําหนด; ..." >

แนวทางการกําหนดสไลดแบบ Inline เชน

bvn/css3/style-inline.html

...
<body>
 <p style="font-size: 186t; font-weight: 
  bold; color: red">
  HTML ใชสําหรับการจัดโครงรางของเว็บเพจ

 </p>
 <span style="background-color: lightskyblue; font-style: italic">
  CSS ใชสําหรับการจัดรูปแบบของเว็บเพจ

 </span> 
</body>

การกําหนดสไตลแบบ Internal
สไตลแบบ Internal จะกําหนดเอาไวที่สวนหัวของเอกสาร เพื+อใหมีผลกับหลาย ๆ  อิลิเมนต โดยไมตอง

เขียนซํ้าซอนกันอีก ดังรูปแบบตอไปนี้
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<style>
 ซีเล็กเตอร { 
      พร็อปเพอรตี-้1: คาที่กําหนด;
      พร็อปเพอรตี-้2: คาที่กําหนด;
      ... 
 }
</style>

สิ่งที่ควรรูเพิ่มเติมเกี่ยวกับสไตลแบบ Internal คือ

 สไตลแบบ Internal ตองกําหนดดวยแท็ก <style> และใหอยูระหวางแท็ก <head>...</head> 

 ซีเล็กเตอร (Selector) เปนตัวที่ใชกําหนดวา จะใหสไตลนั้นนี้มีผลกับอิลิเมนตใด โดยมีซีเล็กเตอร

หลายรูปแบบ เชน Type, ID, Class เปนตน ซึง่รายละเอยีดเกีย่วกบัซเีลก็เตอรแตละแบบ จะกลาวถงึ 

ในหัวขอตอ ๆ  ไป

 พร็อปเพอรตี้และคาของมัน ตองกําหนดไวในวงเล็บ { } เสมอ

 เราอาจเขียนพร็อปเพอรตี้รวมไวในบรรทัดเดียวกันดังโคดที่แลว หรือแยกบรรทัดกันก็ได

bvn/css3/style-internal.html

<head>
 ...
 <style>
  div { font-size: 12pt; }
  p { font-style: italic; }
  span {
   background-color: wheat;
   font-weight: bold;
  }
 </style>
</head>
<body>
 <div>
  <span>การแยกหนาที่ระหวาง HTML และ CSS คือ</span>
  <p>HTML ใชสําหรับการจัดโครงรางของเว็บเพจ</p>
  <span>CSS ใชสําหรับการจัดรูปแบบของเว็บเพจ</span>
 </div>
</body>
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การกําหนดสไตลแบบ External
สไตลแบบ External มักใชกับกรณีที่เราจําเปนตองใชสไตลแบบเดียวกันในหลาย ๆ  เพจ โดยแยกเฉพาะ

สวนสไตลที่ซํ้ากันไปสรางไวที่ไฟลภายนอก แลวเมื+อตองการใชที่เพจใด ก็ทําการเชื+อมโยงกับไฟลนั้น ซึ่งมีให

เลือก 2 วิธีคือ

 วิธีที่ 1 เชื+อมโยงโดยวางแท็ก <link> ไวที่สวนหัวของเพจซึ่งตองการใชสไตล ดังภาพ

 วิธีที่ 2 เชื+อมโยงดวยคียเวิรด @import โดยวางไวในแท็ก <style> ของเพจที่ตองการใชสไตล 

ดังภาพ






